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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.
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Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.
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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract. To register for an HP Passport user ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Introduction to HP Cloud Service 
Automation for Matrix

This section contains the following chapters:

• CSA for Matrix Installation Overview

• What is CSA for Matrix?
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CSA for Matrix Installation Overview

This guide provides high-level information on the HP cloud computing environment, how and where 
HP Cloud Service Automation for Matrix (CSA for Matrix) fits within that environment as a product, 
high-level information on the processes involved in setting up an integrated environment, and specific 
information on installing and configuring CSA for Matrix within that environment.

Successful implementation of CSA for Matrix requires knowledge of the component products, as well as the 
CSA for Matrix solution. Information in this guide augments information provided in the component product 
documentation, but is not intended to replace that documentation. 
11
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Figure 1 identifies the high-level processes required to set up an integrated cloud environment. This figure 
provides the context for the primary integration processes listed in the CSA for Matrix Software column as 
shown in Table 1.

Figure 1 High-Level Process Groups and Processes
12 CSA Integration Guide
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Table 1 High-Level Process Groups for Creating a Cloud Environment 
with CSA for Matrix 

Required Information Before Installation

Before installing CSA for Matrix, refer to the information in Table 2.

Process Group Description

Prepare managed resources Prepare the network, SAN, and server 
infrastructures for CSA for Matrix installation.

Prepare management resources Set up the HP Insight Dynamics CMS, SiteScope 
server, Server Automation server, (optional) HP 
Storage Essentials infrastructure.

Install and configure management software Install, configure, and integrate the HP Insight 
Dynamics CMS software, SiteScope software, 
Server Automation software.
CSA for Matrix includes optional content to 
integrate Insight Dynamics with HP Storage 
Essentials to access a variety of non-Virtual 
Connect-enabled SAN arrays. For this integration 
to work, you must purchase and install HP 
Storage Essentials separately.

Install and configure CSA for Matrix flows 
and templates

Install and configure the CSA for Matrix software 
flows. 

Use CSA for Matrix software Use the CSA for Matrix product templates to 
create services.

Support CSA for Matrix Support the CSA for Matrix product lifecycle and 
the CSA service lifecycle.

Table 2 Required Documentation

Product
Required for 
Installation? Go to...

CSA for Matrix yes Release Notes: http://support.openview.hp.com/selfsolve/manuals

yes Support matrix: http://support.openview.hp.com/selfsolve/manuals

yes Manuals: http://support.openview.hp.com/selfsolve/manuals
NOTES: 
• HP Cloud Service Automation for Matrix Integration Guide provides 

documentation for installation and configuration.
• HP Cloud Service Automation for Matrix Troubleshooting Guide provides 

documentation for troubleshooting installation and end use.
CSA for Matrix Installation Overview 13
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Additional Details

If you want to use CSA for Matrix to integrate Insight Dynamics with HP Storage 
Essentials, you must purchase HP Storage Essentials separately, and install and 
configure HP Storage Essentials with the help of the following documents:

• Support matrix

Available here:

http://support.openview.hp.com/sc/support_matrices.jsp

• Release notes

Available here:

http://support.openview.hp.com/selfsolve/manuals

HP Server 
Automation, 9.02 or 
9.03

yes Support matrix: http://support.openview.hp.com/selfsolve/manuals
NOTE: Search on Server Automation; select Version 9.02 or 9.03 along with 
the target operating system.

yes Manuals: http://support.openview.hp.com/selfsolve/manuals
NOTES:

• User Guide: Application Automation

• Planning and Installation Guide

HP Insight Software, 
6.1 Update 1 or 6.2 
Update 1

yes Support Matrix: http://www.hp.com/go/insightsoftware/docs

• CSA for Matrix supports the detail associated with Insight Dynamics, 
which is further constrained by any requirements noted for Insight 
Orchestration 6.1 Update 1 or 6.2 Update 1.

• CSA for Matrix requires the support packs listed in the support matrix. 

yes Manuals: http://h18013.www1.hp.com/products/servers/management/
hpsim/techsupport.html 
NOTE: Select Installation and technical documentation.
• HP Insight Software Installation and Configuration Guide provides 

documentation for the installation of Insight Orchestration.
• For end-use information, refer to the HP Insight Orchestration User Guide.

yes White papers: http://www.hp.com/go/insightsoftware/docs
Select Insight Dynamics tab; then select

• Insight Dynamics—Automated Storage Provisioning: Static SAN volume 
automation via multi-initiator NPIV for information on static SAN.

• Server and Storage Workflows for HP Insight Dynamics for information 
on using workflows with logical servers.

HP Software 
SiteScope, 11.00 or 
11.01

yes Support matrix: http://support.openview.hp.com/sc/
support_matrices.jsp
NOTE: Check Support matrices short-cuts to find HP SiteScope. Make sure 
you select version 11.00 or 11.01.

no Manuals: http://support.openview.hp.com/selfsolve/manuals

Table 2 Required Documentation

Product
Required for 
Installation? Go to...
14 CSA Integration Guide
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• Manuals

Available here:

http://support.openview.hp.com/selfsolve/manuals
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What is CSA for Matrix? 

CSA for Matrix provides software to integrate specific HP products for the purpose of delivering and 
managing automated infrastructure services in a cloud-computing environment. CSA for Matrix delivers 
monitoring templates for HP SiteScope, work flows for HP Operations Orchestration (HP OO), and 
specialized integration capability for HP Server Automation (HP SA), HP Insight Orchestration (HP IO).

CSA for Matrix also provides an optional integration between Insight Dynamics and HP Storage Essentials. 
To use this integration, you must purchase HP Storage Essentials separately and install HP Storage 
Essentials in your environment before deploying CSA for Matrix.

CSA for Matrix integration assists with the following:

• Automated service provisioning 

• End-to-end service management

This chapter provides conceptual information about the cloud-computing environment. Additionally, it 
describes how CSA for Matrix fits within the a cloud-computing environment by showing its interaction in 
various lifecycles.

Automated Service Provisioning

Design
and Validate

A service is a configuration of IT resources that run a single business application; for 
example, a multi-tier web application. A service includes physical servers (server 
blades, for example) or virtual machines (VMs), each running an operating system, 
middleware, database, or other software. In addition, a service must include storage, 
such as SAN disks or local disks, and a network to provide connectivity.

Automated provisioning begins when a service architect designs a service template. 
The architect has access to an inventory of managed resources and to data center 
policies. 
17
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To create and maintain a library of service templates, the architect uses the template 
designer in HP Software Insight Orchestration (HP IO). The HP IO Designer can be 
accessed from your desktop. It features a drag and drop interface, employing icons to 
manipulate the logical objects used to design and validate a template. 

Figure 2 The HP IO Designer

Customizing a template with work flows allows you to run specific operations before 
or after a provisioning operation. These workflow entries become a part of the 
template, as well as being available for import/export purposes.
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Publish After a service template has been successfully designed and validated, the architect 
publishes the template to the HP IO Self-Service Portal. The published template 
displays in the list of templates, available to all business users who have appropriate 
access and permissions to HP IO.

Figure 3 The HP IO Self-Service Portal

Templates can also be exported to .xml files, so that they can be shared across the data 
center, and easily transferred between server installations. Also, templates can be 
exported in .gif, .jpeg, or Excel file format.

Request Provisioning Business users submit requests for service provisioning through the HP IO 
Self-Service Portal, or through the HP IO Operations Console (Administrators only). 
When HP IO processes a request, it executes a sequence of core and extended tasks to 
allocate resources. Depending on the type of user request, HP IO automates the 
following lifecycle processes:

• Instantiate (or create) a service 

• Modify the service 

• Remove (or de-provision) the service 

For more information about automated provisioning, see the following:

• Using HP Cloud Service Automation for Matrix, Designing Service Templates 
on page 99

• Managing Resources and Services on page 99

• Requesting Services on page 99

End-to-End Service Management

Allocate Resources Resource management is a key component of the CSA for Matrix automation process. 
When a business user requests a service, data center resources must be allocated for 
provisioning. The service administrator creates resource pools. The administrator 
then assigns business users who can use specific server pools and templates. When a 
business user requests a service, the administrator approves the request and the 
resources are automatically reserved from the defined resource pools:

• Virtual machine hosts (where VM can be hosted)
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• Physical machines

• Software 

— OS images

— Software applications (such as IIS, Exchange, Apache)

• Networks 

• SAN storage resources

The administrator’s tasks include managing OS and application software inventory, 
and creating and maintaining resource pools. Additionally, the administrator 
performs manual tasks associated with the lifecycle of services, such as approving 
provisioning requests from business users and managing access to CSA for Matrix 
components.
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Execute Core Process The administrator uses HP IO to coordinate the core provisioning process. This 
process has several key steps, as shown in Figure 4. 

Figure 4 Create Infrastructure Service Request — Core Process

Service Allocation Allocation includes automatically reserving and appropriating resources. Logical 
objects in the service template are matched against available resources from assigned 
server pools, storage pools, network inventory, and software inventory. Reservations 
become allocations. 

1 Request validation: HP IO validates the resources are present that match the 
template selected for service provisioning initiated by a CSA for Matrix business 
user.
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2 Resource reservation: HP IO matches logical objects against available resources. 
If storage resources are not available, the service request pauses and the IO 
administrator is notified. If other resources are not available, the reservation fails.

3 Approval: Approvals are required for all requests submitted by HP IO Self-Service 
Portal users. If an IO administrator creates the service, the processing goes 
forward automatically. 

Service Lifecycle Provisioning includes any task that performs configuration of physical or virtual 
resources, or deployment and configuration of software resources. In terms of time 
consumed and number of overall tasks, provisioning is the major part of the core 
processing.

1 Boot disk provisioning is done using SAN, local disk, or virtual disk (VM). For 
SAN storage, HP IO reserves storage for system start-up. For automated, 
out-of-the-box storage provisioning, CSA for Matrix supports the HP EVA storage 
array and direct-attached storage.

CSA for Matrix—by utilizing Insight Dynamics 6.2 Update 1—supports the 
“Dynamic” SAN volume automation feature with EVA.

The optional integration with HP Storage Essentials also enables you to use the 
“Dynamic” SAN volume automation feature with the HP XP, EMC CLARiiON, 
and HDS storage arrays. For this integration to work, you must purchase and 
install HP Storage Essentials separately. 

For more information, see the Support Matrix for HP Cloud Service Automation 
for Matrix.

2 Pre-provisioning custom configuration: The core provisioning process provides an 
egress point to initiate additional, customized task flows. These task flows include 
any tasks you want to perform as part of core processing before any provisioning is 
started.

3 Server provisioning: HP IO communicates with HP SA to register the server, so 
that provisioning can begin. 

4 Operating system (OS) deployment and configuration: HP IO communicates with 
HP SA to deploy and configure the operating system of the allocated physical or 
virtual servers.

5 Data disk provisioning: HP IO reserves storage for data. CSA for Matrix supports 
the HP EVA storage array for automated, out-of-the-box storage provisioning and 
local disk provisioning. 

CSA for Matrix—by utilizing Insight Dynamics 6.2 Update 1—supports the 
“Dynamic” SAN volume automation feature with EVA.

The optional integration with HP Storage Essentials also enables you to use the 
“Dynamic” SAN volume automation feature with the HP XP, EMC CLARiiON, 
and HDS storage arrays. For this integration to work, you must purchase and 
install HP Storage Essentials separately. 

For more information, see the Support Matrix for HP Cloud Service Automation 
for Matrix.

6 Post-provisioning custom configuration: The core provisioning process provides an 
egress point to initiate final processing of HP OO flows; these include any tasks 
you want to perform after provisioning is complete.

7 Software patching and compliance: HP SA operates in its normal capacity to 
provide patching and compliance functionality on the provisioned servers.
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8 Service de-provisioning: HP IO communicates with HP Server Automation (SA) to 
de-provision allocated resources. Servers will be removed from HP SA.

Support for Different Types of IT Infrastructure

Physical servers The CSA for Matrix solution provides out-of-the-box support for HP BladeSystem 
c-Class servers using HP Virtual Connect technology. CSA for Matrix also supports 
provisioning for hardware that is not enabled through HP Virtual Connect by using 
embedded HP Operations Orchestration (HP OO) workflows. 

CSA for Matrix includes a reference implementation of the HP OO work flows 
required to provision non-Virtual Connect HP hardware. This reference 
implementation may be used with specific ProLiant rack mount servers.  

Virtual servers CSA for Matrix supports virtual server provisioning using hypervisors from Microsoft 
and VMWare. 

Storage arrays CSA for Matrix provides out-of-the-box support for the HP EVA storage solution. In 
addition, you can use the “Dynamic” SAN volume automation feature for the following 
SAN arrays: HP EVA, HP XP, EMC CLARiiON, and HDS. This feature is available 
only if you choose to use HP Insight Dynamics (6.2 Update 1) and HP Storage 
Essentials with the optional integration workflows for HP Storage Essentials. You 
must purchase HP Storage Essentials separately.

CSA for Matrix Lifecycles

CSA for Matrix automates infrastructure setup, maintenance, and end-of-life 
processes. This guide focuses primarily on the CSA for Matrix product lifecycle that 
includes requirements, installation, and use. Table 3 provides more information about 
each step.

• The Preparing Managed Resources and Preparing Management Servers chapters 
focus on requirements gathering, analysis and design, and deployment of the 
component products that are prerequisites for the deployment of CSA for Matrix. 

Support from HP for utilizing the reference implementation HP OO work flows on 
non-HP hardware is neither expressed nor implied.

Table 3 Process Lifecycle Steps

Business Process Description For more information

Gathering and Analyzing 
Requirements

Collection of IT management system 
requirements 

Business-specific projections and 
policies.

Installing CSA for Matrix Installation and configuration tasks See Figure 5

Using CSA for Matrix Template design and core provisioning See Figure 6.

Troubleshooting CSA for Matrix Support and upgrade tasks
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• The Installing and Configuring Management Server Software and Installing and 
Configuring CSA for Matrix Flows and Templates chapters focus on the 
deployment of CSA for Matrix. These chapters form the core of the integration 
guide. 

• The Using HP Cloud Service Automation for Matrix corresponds to the end use of 
CSA for Matrix. This chapter contains references to the HP IO and HP OO 
products. Once integrated, the CSA for Matrix product is presented to the end 
user through those products. 
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Figure 5 shows which process groups from Figure 1 show the CSA installation, 
configure, and validate processes. Table 4 provides more information about each step.

Figure 5 Installation Processes

Table 4 Installation Process within CSA for Matrix Product Lifecycles

Business Process Description For more information

Install Prepare and build the system 
according to the design

See Preparing CSA for Matrix on page 27 
and Install and Configure CSA for Matrix 
on page 41. Documentation for sub-products is 
listed in the Required Information Before 
Installation on page 13.

Configure Configure hardware and 
software. Systematically 
integrate the components.

See Preparing CSA for Matrix on page 27 
and Install and Configure CSA for Matrix 
on page 41. Documentation for sub-products is 
listed in the Required Information Before 
Installation on page 13.

Validate Evaluate and adjust the 
system as components are 
integrated.

Validate throughout the installation process.
What is CSA for Matrix? 25



CSA for Matrix 2010.12
Figure 6 shows a CSA for Matrix automation process overview. Table 5 provides more 
information about each step.

Figure 6 An Overview of the CSA for Matrix Automation Process

Table 5 Process Automation Steps

Description  Component For more information...

The architect designs and tests service 
templates; then publishes them to the 
list of templates on IO Portal.
Using the list of available templates, 
the business user requests that a 
service be created, modified, or 
removed.
The service administrator receives 
and approves the request from the 
business user. 

HP Insight Orchestration Refer to Table 2 on page 13 for a 
list of related documentation.

CSA for Matrix workflows and 
templates integrated with HP SA, 
HP Insight Orchestration, embedded 
HP OO and HP SiteScope perform the 
automated service creation.

CSA for Matrix, HP Server Automation, 
HP Insight Orchestration, HP OO, 
HP SiteScope

Troubleshooting CSA for Matrix, HP Server Automation, 
HP Insight Orchestration, HP OO, 
HP SiteScope

The service terminates. CSA for Matrix, HP Server Automation, 
HP Insight Orchestration, HP SiteScope
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Preparing CSA for Matrix
This section contains the following chapters:

• Preparing Managed Resources

• Preparing Management Servers

Figure 7 Preparing Resources Focuses on Managed and Management Resources

The primary audience for this section is the deployment consultant responsible for setting up the network 
infrastructure.

Most of the documentation needed for this phase of integrating CSA for Matrix is contained in documents for 
products that integrate with CSA for Matrix—both HP products and vendor products. The high-level 
description in this section provides context.
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Preparing Managed Resources

In some installations, an installer might install a hardware component, install its software, and then move to 
the next component. Alternatively, in an enterprise system where there is a large team, hardware might be 
installed by one person or group and configured by another. 

The sections that follow are modularized so they can be used sequentially or in parallel. Information here is 
presented at a high level, including processes beyond the basic CSA installation, which provide a conceptual 
context.

This chapter contains the following sections:

• Getting the Network Ready

• Getting the SAN Ready

• Getting the Servers Ready

Figure 8 Preparing Managed Resources
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Getting the Network Ready

Getting the network ready is a prerequisite for installing and configuring CSA for 
Matrix, and involves installing the necessary hardware and software, and creating the 
connections (physical or logical) between switches and managed devices. Detailed 
instructions are out of scope for this document.

Figure 9 Getting the Network Ready

Set Up the Network Environment

Physical setup of the network involves installing physical components, configuring the 
logical network, and documenting and verifying connections. 

1 Plug in cables and switches. 

2 Set up VLANs.

3 Record physical connections.

4 Verify connections and VLANs.

Several additional steps are completed when the HP Insight Dynamics CMS and 
HP SA server software are set up:

• DNS requires both forward and reverse lookup. Any static IP address used by any 
device in the environment should have an entry, including the management point 
for storage arrays.

• Provisioning requires

— DHCP

— PXE

— NFX/CIFS/SMB
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Getting the SAN Ready

SAN preparation, if a SAN is used, involves installing hardware and creating the 
physical connections between switches, storage arrays, and volumes. Detail here is at 
a high-level.

Figure 10 Getting the SAN Ready

CSA SAN Prerequisites

Enterprise Virtual Array (EVA) is required for physical SAN support. In addition, you 
can use the “Dynamic” SAN volume automation feature for the HP EVA, HP XP, EMC 
CLARiiON, and HDS SAN arrays if you choose to use the optional integration 
between HP IO and HP Storage Essentials available with CSA for Matrix.

Supported SAN Arrays

You can use the “Dynamic” SAN volume automation feature for the HP EVA arrays if 
you use Insight Dynamics 6.2 (Update 1).

If integrated with Storage Essentials by using the supplied optional integration, the 
CSA for Matrix solution supports the “Dynamic” SAN volume automation for the 
following SAN arrays:

• HP XP arrays
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• HP EVA

• EMC-CLARiiON

• HDS

If you use EMC-CLARiiON, make sure the following requirements are met:

• An initiator port must be registered with the CLARiiON storage system before 
you use the initiator port while creating the Storage Pool Entry (SPE).

• If a server has multiple initiator ports, each initiator port must be registered with 
the CLARiiON storage system with a unique IP address. If multiple initiator ports 
are registered with the same IP address, the Selective Storage Presentation or 
creation of SPE will fail.

Set Up the SAN Environment

Logical connections can be discovered after management software has been installed, 
if you are using Virtual Connect (VC). Some configuration of VSANs, zones, and 
switch fabrics may be required at this stage. The storage management interface needs 
to be ready during the discovery setup of configuration and before the first OS 
provision. The following steps are a high-level summary; component documentation 
should be used for specific instructions.

1 Set up SAN components.

a Set up EVA for physical SAN support.

If you want to use the “Dynamic” SAN volume automation feature, set up the 
SAN arrays of your choice (HP EVA, HP XP, EMC CLARiiON, or HDS).

b Set up SAN switches (such as Brocade, Cisco, or Mcdata).

2 Set up VC-enabled components (optional).

a Set up blade servers.

b Set up HBAs.

c Set up switches.

3 Configure VSANs, zones, and switch fabrics, as needed.

4 Record physical and logical connections that cannot be discovered by VC and 
Virtual Connect Enterprise Manager (VCEM).

5 Verify.

Virtual Connect when used with VCEM, allows administrators to discover and 
manage server connections from a console. When using hardware that is 
non-VC-enabled, physical and logical connections must be manually recorded in the 
ServerInfo.xml file.

CSA for Matrix uses the following approaches:

• Insight Dynamics Static SAN approach; for more information about this 
configuration see the white paper: Insight Dynamics —Automated Storage 
Provisioning: Static SAN volume automation via multi-initiator NPIV at http://
h18004.www1.hp.com/products/solutions/insightdynamics/
info-library.html.

• “Dynamic” SAN volume automation approach; for more information about this 
feature, see the HP Insight Orchestration 6.2 User Guide.
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Getting the Servers Ready

Getting the servers ready is a prerequisite for installing and configuring CSA for 
Matrix. Detail here is at a high-level with links to resources for accomplishing the 
tasks.

Getting the servers ready involves installing the hardware and creating the physical 
connections between the servers and the switches.

Figure 11 Getting the Servers Ready

CSA Server Prerequisites

CSA for Matrix operates on VC-enabled blade servers, ProLiant servers, and virtual 
machine (VM) hosts on ProLiant servers.

Set Up Servers 

The following steps are a high-level summary; component documentation should be 
used for specific instructions.

1 Set up server components.

2 Establish connections between servers and switches.

3 Record logical and physical connections.

4 Verify.
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Preparing Management Servers

This chapter provides links to information on preparing the management-server hardware infrastructure. 
This chapter contains the following sections:

• Preparation Overview 

• Preparing the HP Server Automation Server

• Preparing the HP Insight Dynamics CMS Server

• Preparing the HP SiteScope Server

• Optional. Preparing the HP Storage Essentials Management Server

Preparation Overview

The CSA for Matrix configuration consists of the following servers:

• HP Server Automation (HP SA) running on one or more servers (in a single Core or 
Satellite installation).

• HP Insight Dynamics Central Management Server, which includes HP Systems Insight 
Manager (HP SIM) running on one server that hosts HP Insight Orchestration (HP IO) 
and its embedded version of HP OO.

• HP SiteScope running on one server.
35



CSA for Matrix 2010.12
You can set up the hardware and connections for these servers in any order and 
concurrently. However, HP SA software should be installed before HP IO software if 
this is a new installation. You must install and configure all of the servers before 
configuring the CSA for Matrix flows and templates.

Figure 12 Preparing Management Resources
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Preparing the HP Server Automation Server

Figure 13 Preparing the SA Server

HP SA Server Prerequisites

Minimum Hardware Requirements

Information on how to determine the minimum configuration to match your target 
environment can be found in the Server Automation Planning and Installation Guide. 
See Required Information Before Installation on page 13.
Preparing Management Servers 37



CSA for Matrix 2010.12
Preparing the HP Insight Dynamics CMS Server

Figure 14 Preparing the HP Insight Dynamics CMS Server

HP Insight Dynamics CMS Server Prerequisites

Hardware Requirements

Memory: 32 bit OS 8 GB minimum, 12 GB preferred 
for 64 bit OS 16 GB minimum

Storage: 30 GB minimum, 60 GB preferred

Processors: 1 minimum, 4 preferred

These requirements are verified when the software is configured.

Confirm minimum requirements using the detailed instructions for building the 
HP Insight Dynamics CMS environment in the HP Insight Orchestration User Guide. 
See Required Information Before Installation on page 13.
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Preparing the HP SiteScope Server

Figure 15 Preparing the SiteScope Server

HP SiteScope Server Prerequisites

Hardware Requirements

Memory: 1 GB minimum, 2 GB preferred

Storage: 20 GB minimum, 30 GB preferred

Processors: 1 minimum, 2 preferred

These requirements are verified when configuring the software.

It is recommended that only the Windows version of SiteScope be used, if you are 
planning to monitor servers running Windows. The Linux version does not support 
the monitoring of servers running Windows, except in the limited (non-standard) case 
in which SSHD is running on the Windows server. The Solaris version has not been 
tested with CSA for Matrix. See Required Information Before Installation on page 13.
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Preparing the HP Storage Essentials Management Server

This is an optional section. Skip this section if you do not want to use HP Storage 
Essentials with CSA for Matrix.

Figure 16 Preparing the HP Storage Essentials Management Server

HP Storage Essentials Management Server Prerequisite
Make sure you install HP Storage Essentials 6.3 in your environment. See the HP 
Storage Essentials Release Notes and HP Storage Essentials Installation Guide while 
setting up the HP Storage Essentials environment.
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Install and Configure CSA for 
Matrix

This section contains the following chapters: 

• Installing and Configuring Management Server Software

• Installing and Configuring CSA for Matrix Flows and Templates

Figure 17 lists the high-level processes associated with installing management server software and installing 
the CSA for Matrix flows and templates. These are the core processes associated with integrating the CSA for 
Matrix software in your cloud-computing environment.

Figure 17 Install and Configure Management Software and CSA for Matrix 
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Installing and Configuring Management Server 
Software

This chapter contains the following sections:

• Preparation Overview

• Installing and Configuring HP SA for Use with CSA for Matrix

• Installing and Configuring HP SiteScope for Use with CSA for Matrix

• Installing and Configuring the HP Insight Dynamics CMS for Use with CSA for Matrix

• Optional. Configuring HP Storage Essentials for Use with CSA for Matrix

You can set up the physical or virtual servers, install the primary operating system, install and configure the 
infrastructure hardware, and address CSA for Matrix prerequisites in serial or in parallel.

On new installations, HP Server Automation software should be installed and 
configured before the HP Insight Dynamics CMS software is installed.

HP SA, HP SIM, HP IO with embedded OO, and HP SiteScope must be installed and 
configured before CSA for Matrix flows and templates are installed.
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Preparation Overview

Figure 18 depicts the preparation for installing and configuring management 
software.

Figure 18 Preparation Overview

This chapter assumes that HP SA is installed prior to the HP Insight Dynamics CMS. 
If the HP Insight Dynamics CMS has been installed first, perform the installation 
steps for HP SA as listed; then re-configure the CMS using the steps listed in 
Completing the HP SA Configuration for the HP Insight Dynamics CMS and CSA for 
Matrix on page 61.

The CSA for Matrix configuration consists of the following separate servers:

• HP Server Automation (HP SA) running on one or more servers in a single core 
installation. HP SA may be installed prior to or after the installation of Insight 
Dynamics. 

— If HP SA is installed first, the installation/configuration steps are as follows:

For the performance and stability of the Cloud Service Automation for Matrix 
environment, it is very important to meet the minimum requirements for main 
memory, disk space, and processors for each of the component products. 
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1. HP SA core installation

2. Insight Dynamics core installation

3. Insight Dynamics configuration for CSA for Matrix

4. HP SA configuration for CSA for Matrix

5. HP SiteScope core installation

6. HP SiteScope configuration for CSA for Matrix

— If Insight Dynamics is installed first, installation/configuration steps are as 
follows:

1. Insight Dynamics core installation

2. HP SA core installation

3. Insight Dynamics configuration for CSA for Matrix

4. HP SA configuration for CSA for Matrix

5. HP SiteScope core installation

6. HP SiteScope configuration for CSA for Matrix

• HP Systems Insight Manager (HP SIM) running on one server (CMS) that hosts 
HP Insight Orchestration (HP IO).

• HP SiteScope running on one server.
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Installing and Configuring HP SA for Use with CSA for Matrix

Figure 19 lists the subprocesses involved in installing HP SA.

Figure 19 Installing HP SA for CSA for Matrix

SA Minimum Version Requirements 

The general requirements for HP SA for use with CSA for Matrix are listed below:

• In the earlier version of CSA for Matrix, the HP SA build manager was required to 
be in the same subnet as the servers that are managed by CSA for Matrix. In the 
current release, HP IO can support SA satellite configurations. In addition, 
network configuration utilizing a DHCP relay (such as IP Helper) can be 
configured so that the SA build manager no longer has to reside on the same 
subnet as the target servers.

• SA 9.02 or 9.03 must be installed.

Determine minimum requirements using the detailed instructions for building the 
HP SA environment addressed in the HP Server Automation Planning and 
Installation Guide. See Required Information Before Installation on page 13.

When you install SA, you need to keep a copy of the oiresponse.omdb file after the 
installation is complete. This file is typically kept in /usr/tmp. Be sure to save a copy 
because the file is deleted upon reboot. 
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• CSA for Matrix requires that HP SA act as the DHCP server for the managed 
environment.

• Determine the account name of the HP SA user to connect between HP IO and 
HP SA. This HP SA user name is used in the following locations:

— After HP SA is installed, you set up an HP SA account for this user name.

— You supply this account name during the HP SIM installation.

For more information about HP SA requirements, see the HP Server Automation 
Planning and Installation Guide. See Required Information Before Installation on 
page 13 for information.

Build the HP SA Environment

In brief, the process involves:

SA 9.00

• Installing the oracle-sas packages

• Installing the primary packages

• Installing the upload packages

SA 9.02 or 9.03

• Installing opsware-patch

• Installing opsware-patch_upload

DHCP Configuration

CSA for Matrix assumes that HP SA acts as a DHCP server for the managed 
environment. To enable the HP SA DHCP server functionality, follow these steps:

1 Log in to the HP SA primary core using the root account.

2 In any text editor, open the following file:

/etc/opt/opsware/dhcpd/dhcpd.conf

3 Uncomment the “authoritative” line by removing the number sign (#).

4 Save the file.

5 Run the following command:

/opt/opsware/dhcpd/sbin/dhcpdtool

Follow the prompts to fully enable the DHCP service.

Set up the OS provisioning images and software policies. Consult the HP SA User 
Guide: Application Automation document for version 9.0x. See Required Information 
Before Installation on page 13 for information. Validate the HP SA Installation 
without CSA for Matrix.

It is strongly recommended that you validate your installation of HP SA before 
integrating CSA for Matrix. Follow normal procedures for incorporating an operating 
system into HP_Server Automation; then deploy an operating system directly from 
HP SA to a target server or servers in your environment.
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HP Server Automation (HP SA) Configuration 

The next step involves both validation and configuration of the SA primary core or the 
Satellite host. 

HP SA Topology and Scaling Limitations 

This version of CSA for Matrix supports the following configurations:

Even though an SA installation may contain multiple cores, the CSA for Matrix 
installation must be configured to register the primary core or the Satellite host with 
the CMS. In an environment with multiple Slice Component bundle instances, 
BladeSystem Matrix cannot auto-failover to any Slice Component bundle installation 
that is not registered with the CMS. If you change the SA primary core or the Satellite 
host that is registered with the HP Insight Dynamics CMS, you must update all 
existing service templates to correctly identify the new software location.

This version of CSA for Matrix supports provisioning of operating systems from SA 
Satellite hosts.

Table 6  HP BladeSystem Matrix Topology

SA Component Topology Supported

Managed servers on the same subnet of an 
SA primary core with no Slice Component 
bundles

Yes

Managed servers on the same subnet of an 
SA primary core with multiple Slice 
Component bundles

Yes

Managed servers behind SA Satellites Yes

Managed servers on the same subnet as that 
of the HP SA Satellite host (the OS 
provisioning component must be available on 
the Satellite host).

Yes

Multimaster Mesh: managed servers on the 
same subnet as that of the SA primary core 
that is registered with the HP Insight 
Dynamics CMS

Yes

Multimaster Mesh: managed servers on the 
same subnet as that of an SA primary core 
that is not registered with the HP Insight 
Dynamics CMS

No

Multimaster Mesh: managed servers on the 
same subnet as that of the HP SA Satellite 
host that is registered with the HP Insight 
Dynamics CMS.

Yes

Multimaster Mesh: managed servers on the 
same subnet as that of the HP SA Satellite 
host that is not registered with the 
HP Insight Dynamics CMS.

No
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In addition, if there are create service requests that have been submitted to the 
system for a future time (a future reservation), these requests must be cancelled 
explicitly and then re-submitted with an updated service template that contains the 
new software location. Failure to perform this step results in the request failing when 
the system tries process the old software location. 

Updating HP SA Security and Roles

Task 1: Create a CSA for Matrix Account Group

1 Log in to the SAS Web Client as an HP SA Administrator.

2 In the navigation pane, under Administrators, click Users & Groups.

3 On the Groups tab, click New Group.

4 Enter a group name, for example: HPIO Administrators.

5 Set the following customer permissions:

6 Save the new group.

7 On the Groups tab, open the newly created group and apply the following settings:

a On the Facilities tab, set Read&Write access to the facility where the 
BladeSystem Matrix managed servers are assigned.

b On the Devices Groups tab, select the Select all device groups check box.

c On the Features tab, select at least the following features:

Facilities

Managed Servers and Group

Model: Opsware

d On the Client Features tab, set the following permissions. (Leave all other 
features set to No or None)

Policy Management: <Policy>

Manage Software Policy: Read

Allow Attach/Detach Software Policy: Yes

OS Sequence Management: <OS Sequence Management>

Manage OS Sequence: Read

Allow Execute OS Sequence: Yes

Allow Configuration of Networking Booting: Yes

Servers:<Servers>

Customer Name Permission

HP Administrators Read&Write

Not Assigned Read&Write

Opsware Read or Read&Write

Any other customers None
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Allow Remediate Servers: Yes

8 Under Manage API Permissions on the Other Permissions tab, select the Manage 
Virtual Columns check box.

9 Do not set anything on the OGFS Permissions tab.

Task 2: Create an Account for HP BladeSystem Matrix to access HP SA

Use this account name when completing the CMS configuration steps below. CSA for 
Matrix uses this account name during HP SA OS and Application policy provisioning. 
You must use the same account name and password in both HP SA and CSA for 
Matrix.

1 In the SAS Web Client, create a new user, for example: hpiosa.

2 Assign this new user to the user group that you created in Task 1: Create a CSA 
for Matrix Account Group.

Verification of SA OS Sequence and Application Policy Inventory 

In order to make HP SA OS Sequences and Application Policies available to CSA for 
Matrix, you create a basic folder structure to which you assign CSA for Matrix Group 
Permissions. Figure 20 illustrates one example of this approach.

Figure 20 OS Sequences and Application Policies
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In this example, two folders are created. One to house the OS Sequences and one to 
house the Application Policies that are accessible to CSA for Matrix. The folder 
permissions must be set to permit CSA for Matrix Group access. For the example 
below, the group name used for this purpose is HPIO Administrators. 

1 Right click on the folder name: hpio_os_policies.

2 Add the HPIO Administrators group. 

3 Ensure that the following permissions are selected: 

a List Contents of Folder 

b Execute Objects Within Folder 

c Read Objects Within Folder

d Write Objects Within Folder

Figure 21 Setting Group Permissions for a Policy Folder 

After completing the process above, any OS Sequences or Application Policies that are 
assigned to the folders become available to CSA for Matrix for use in service 
provisioning operations. Specifically, OS Sequences and Application Policies begin to 
show up within CSA for Matrix as available software inventory. 
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OS Provisioning APX Extensions 

The service provisioning process makes use of several HP SA APX extensions to 
perform its lifecycle operations. 

Figure 22 Required HP SA APX Extensions 

1 The EraseDisk APX is used to clean a server during the service delete process. All 
storage that is visible to the server is erased prior to the server (and its storage) 
being returned to the inventory for a future provisioning request. 

2 The Post Install Network Configuration APX is used to perform OS level 
personalization of the server at the end of the OS provisioning process. 

As is the case with OS Sequence and Application Policy folders, it is also necessary to 
set the folder permissions to permit Group access. For the example below, the group 
name for this purpose is HPIO Administrators. 

1 Right click on the folder name: BRDC Support. 

2 Add the HPIO Administrators group. 

3 Ensure that the following permissions are selected: 

a List Contents of Folder 

b Execute Objects Within Folder 

c Read Objects Within Folder
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Figure 23 Setting Group Permissions for the OS Provisioning APX 
Extensions 

Guidelines for Provisioning Operating Systems to Servers on Distinct Networks

You can use CSA for Matrix to provide operating system provisioning and network 
boot services to distinct networks by using one of the following setups:

• SA Satellite Host

• DHCP Relay

SA Satellite Host

You can use the SA Satellite host to provision operating systems to servers on 
multiple distinct networks. Make sure that the CMS and SiteScope server can 
communicate with the managed systems under the SA Satellite.
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DHCP Relay

You can use DHCP relays to provision operating systems to servers on multiple 
distinct networks.

If you want to use this method, you must perform the following configuration tasks:

1 Configure a Layer 3 switch, router, or dual-homed system to transmit BOOTP and 
DHCP broadcast to the SA Core or Satellite. 

2 Configure a single SA Core or Satellite host to run the SA OS Provisioning Boot 
Server component. This system must be routable by each target network.

3 Configure the DHCP service to cater to DHCP requests from the remote network.

For example:

subnet 192.168.10.0 netmask 255.255.255.0 {

   range dynamic-bootp 192.168.10.100 192.168.10.250;

   option broadcast-address 192.168.10.255;

   option domain-name "vlan10.example.com";

   option domain-name-servers 192.168.10.2;

   option routers 192.168.10.1;

}

subnet 192.168.11.0 netmask 255.255.255.0 {

   range dynamic-bootp 192.168.11.100 192.168.11.250;

   option broadcast-address 192.168.11.255;

   option domain-name "vlan11.example.com";

   option domain-name-servers 192.168.11.2;

   option routers 192.168.11.1;

}

subnet 192.168.12.0 netmask 255.255.255.0 {

   range dynamic-bootp 192.168.12.100 192.168.12.250;

   option broadcast-address 192.168.12.255;

   option domain-name "vlan12.example.com";

   option domain-name-servers 192.168.12.2;

   option routers 192.168.12.1;

}

4 Make sure that the CMS, SiteScope server, and SA servers are able communicate 
with remote networks.

This can be configured by using the dhcpd tool or by manually editing the /etc/opt/
opsware/dhcpd/dhcpd_subnets.conf file.
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Installing and Configuring the HP Insight Dynamics CMS for Use 
with CSA for Matrix

Figure 24 outlines the installation of HP Systems Insight Manager (HP SIM), the 
HP Insight Dynamics CMS. This chapter lists considerations for installing the HP 
Insight Dynamics CMS software to support CSA for Matrix integration. 

Figure 24 Installing HP Insight Dynamics CMS for use with CSA for Matrix

Satisfy the HP Insight Dynamics Prerequisites

Determine minimum requirements using the detailed instructions for building the 
HP Insight Dynamics environment in the HP Insight Orchestration Installation and 
Planning Guide. See Required Information Before Installation on page 13.
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Insight Dynamics Minimum Requirements

When configuring CSA for Matrix for use with HP Server Automation, verify the 
software versions that are currently deployed on the CMS.

Microsoft Software Requirements

• Windows 2003/2008 Standard, Enterprise or data center edition, 32 or 64 bit, 
except Windows 2003 Standard edition 32 bit, which does not support more than 
4GB of memory. All versions require the latest Service pack from Microsoft. 

• After installation of Windows Server is complete, change the Data Execution 
Prevention (DEP). Change the DEP to Opt-In or Only for essential Windows 
programs and services.

From the Microsoft Installation Media

1 From Add or Remove Programs in the Control Panel, select Add/Remove Windows 
Components.

2 From Application Server Details select ASP.NET; then select Details for IIS.

3 Add the FTP server (not necessary on Windows 2008). 

4 From Management and Monitoring Tools Details; select Simple Network Management 
Protocol.

5 After SNMP is installed, configure SNMP from the services applet and select 
SNMP Service properties.

6 Under Security, select Accepted Community Names and select Add.

a Select READ WRITE.

b Provide a community name.

c Select OK and then select OK again. 

7 Select Microsoft .NET Framework 2.0.

Other Microsoft Packages

• Install .NET 3.0 and update it to .NET 3.5.

• Optional. For Windows Server 2003, install the Microsoft iSCSI Driver 
installation/Microsoft iSCSI Software Initiator 2.06 or 2.07 or 2.08, which is 
available at: http://www.microsoft.com/downloads/
details.aspx?displaylang=en&FamilyID=7a133e76-5524-4362-bad7-81fe696
8bba

• Optional. Windows Automated Installation Kit. Requires MSXML installation 
from media (adds a service pack to existing MSXML). 

• After installation of the above Microsoft products and features, install all of the 
latest service packs and hotfixes. 

To confirm that hardware requirements are adequately addressed, run Insight 
Advisor. You have the option to do this when you run the integrated installer.
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Non-Virtual-Center-Enabled Software

• Adobe Flash Player Installation (required)

— http://www.adobe.com

• Adobe PDF reader (optional)

— http://www.adobe.com

Virtual Center (VC)

If an ESX server is to be used by the HP Insight Dynamics CMS, VC must be 
installed. VC must be installed on a separate server, not on the CMS. You must add 
VC licensing before adding the VC server to the domain. See Required Information 
Before Installation on page 13.

Install the Insight Dynamics Software

HP Insight Dynamics is supported on Windows 2003 and Windows 2008. This section 
is provided as a reference. Install Insight Dynamics prior to installing CSA for Matrix. 
See Required Information Before Installation on page 13 for information on Insight 
Dynamics documentation.

Run the Integrated Installer

1 Run Insight Software Advisor. This verifies that all prerequisites have been passed 
before you attempt the install.

— If all prerequisites are met, continue with step 2.

— If some prerequisites are not met, exit and address them. After addressing 
prerequisites, repeat step 1 until all prerequisites pass.

2 Run Review PreInstallation Checklist.

3 Select System Insight Manager and select Customize.

4 Add HP Insight Control Virtual Machine Management (VMM).

5 Add HP Virtual Connect Enterprise Management (VCEM).

6 Add Insight Dynamics Infrastructure Orchestrator (HPIO).

7 Press OK in the popup dialog to add the other packages.

8 Press Next.

9 Select your preferred method to access DVD #2.

10 Either use the default installation location or enter a new one and confirm to 
create the new directory.

11 Enter the Service Account credentials.

12 Install SQL.

You need the name of the HP SA user to connect between HP IO and HP SA. This 
HP SA user name is used in step 17 on page 58.
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13 Enter the password to enable auto-sign-in, so that the installation can reboot and 
continue.

14 Enter the proxy configuration or accept the default proxy configuration. 

15 Configure WMI Mapper port.

16 Configure the Insight Dynamics configuration management location to store the 
data.

17 Select HP SA as the deployment server and enter the credentials that HP IO uses 
to connect to the HP SA server:

a Enter the HP SA IP address.

b Enter the account. (This is the new user account created in Task 2 on 
page 50.)

c Enter the password.

18 Select Install.

Apply the Update 1 Patch for HP Insight Dynamics

After installing HP Insight Dynamics, you must apply the Update 1 patch kit.

Update Extensible Storage and Server Adapter (ESA) Workflows to the Version 1.2.1.1 on the 
HP Insight Dynamics CMS 6.2 Update 1

Follow this procedure only when you are using the HP Insight Dynamics CMS 6.2 
Update 1. You must complete this procedure if you want to use Storage Essentials 
workflows for dynamic storage provisioning.

1 On the HP Insight Dynamics CMS 6.2 Update 1, go to the directory 
<vse_install_path>\esa\ref impl.

2 Extract the contents of the file ESA-OO-RefImpl.zip file (which is available in 
the directory <vse_install_path>\esa\ref imp) into a local directory (for 
example: C:\temp). 

All the contents of the file are placed inside the ESA-OO-RefImpl directory 
under the chosen target directory (for example: inside 
C:\temp\ESA-OO-RefImpl).

3 Go to the ESA-OO-RefImpl directory, and then run the following script:

setupESA_IActionJars.bat 

4 Import ESA’s repository to the embedded OO:

a In OO Studio, expand Library > Hewlett-Packard, right-click ESA, and then select 
Delete.

b Select Repository > Import Repository. 

At this point the installer verifies that it can connect to the HP SA server at this IP 
address with these HP SA server credentials.

If the manual process was selected for the second DVD, the install will prompt for the 
second DVD when approximately 45% complete. Overall installation time will be 3-4 
hours depending on speed of system and access speed of the DVD or DVD ISOs.
58 CSA Integration Guide



CSA for Matrix 2010.12
c In Select Repository Directory dialog box, navigate to the location 
<extract_directory>\ESA-OO-RefImpl\OOWorkflows.

In this instance, <extract_directory> is the directory where you extracted the 
contents of the ESA-OO-RefImpl.zip file.

d Click Open. The Importing From... window opens.

e Click Expand All. Make sure the ESA folder is set to Add in Repository in 
the Action column.

f Click Apply.

g Click OK.

Installing and Configuring HP SiteScope for Use with CSA for 
Matrix

Figure 25 Installing and Configuring HP Site Scope for CSA

See Required Information Before Installation on page 13 for information on 
HP SiteScope documentation.

HP SiteScope installation consists of the following five tasks:

• Task 1: Verify the System Resources
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• Task 2: Evaluate the Existing HP SiteScope Installation

• Task 3: Install the HP SiteScope Software

• Task 4: Gather HP SiteScope Information for CSA for Matrix

Task 1: Verify the System Resources

1 Using the information in HP SiteScope documentation, calculate the resources 
needed for the HP SiteScope server. 

2 In this calculation include the number of target servers that you expect CSA for 
Matrix to manage.

Task 2: Evaluate the Existing HP SiteScope Installation

The currently supported HP SiteScope installation process consists of installing 
SiteScope 11.00 (a full installation), followed by HP SiteScope 11.01 (a patch that 
requires 11.00 to be already installed). If using an earlier version of HP SiteScope, the 
system must be updated. If a later version of HP SiteScope is available, verify that it 
is supported in the CSA Support Matrix. If necessary, upgrade the HP SiteScope 
software to the required version.

Task 3: Install the HP SiteScope Software

Prerequisites

You must have Java installed for the web browser on the CMS to run HP SiteScope. 
You can find downloads for current Java installations by operating system here:

http://java.com/en/download/manual.jsp.

Run the HP SiteScope installer 

During installation, you can change the port for the HP SiteScope service to avoid 
potential conflicts with other web servers that use the default port value of 8080. 
Select any available port on the system. Keep track of the port number that you select.

Patch Requirement

If you are using HP SiteScope 11.00, you must install the SiteScope 11.00 Cumulative 
fixes (SIS_00088) patch on the SiteScope server.

Apply HP SiteScope licenses

• Overall license

• Licenses for additional monitoring capabilities, depending on the hardware 
and software in the managed environment

Task 4: Gather HP SiteScope Information for CSA for Matrix

Note the IP address and port of the HP SiteScope server. You must supply this 
information to HP IO while configuring the CSA for Matrix software. 
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Completing the HP SA Configuration for the HP Insight Dynamics 
CMS and CSA for Matrix

Since the HP Insight Dynamics CMS and HP SA interact with each other, final 
configuration of HP SA can be done after the HP Insight Dynamics CMS installation.

Figure 26 Completing HP SA Configuration 

Configure HP Insight Dynamics to Use HP SA 9.02 or 9.03

By default, HP Insight Dynamics (6.1 Update 1 or 6.2 Update 2) works with HP SA 
7.83. To configure HP Insight Dynamics to work with HP SA 9.02 or 9.03, follow these 
steps:

1 On the CMS, stop the HP Systems Insight Manager service.

2 Log on to the SA 9.02 or 9.03 Core, and then copy the following file:

/opt/opsware/twist/extlib/client/opswclient.jar 

3 Place the opswclient.jar file in the following location on the CMS:

<SIM_INSTALL_PATH>\lib

4 If you are using HP Insight Dynamics 6.1 Update 1, follow these steps:
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a Go to the following web address:

https://h22042.www2.hp.com/servlets/
ProjectDocumentList?folderID=586/

b Log on to the web site (HP Live Network) with HP Passport credentials.

c Download the SAplugin.jar file from the web site.

d Place the SAplugin.jar file in the following location on the CMS:

<SIM_INSTALL_PATH>\lib

5 If you are using HP Insight Dynamics 6.2 Update 1, follow these steps:

a Copy the following file on the CMS:

%HPIO_Home%\update\6.2.1\SA9.x_support\SAplugin.jar 

b Place the SAplugin.jar file in the following location on the CMS:

<SIM_INSTALL_PATH>\lib

6 Restart the HP Systems Insight Manager service on the CMS.

Identify Existing SIM MxNode Registrations

During the installation of the Insight Dynamics CMS, a placeholder may have been 
used to point to an HP SA server. To see if an HP SA server was set up, open a 
command shell and enter the following:

mxnodesecurity -l

Scan through the list and see if the PROTOCOL of dsc_sas exists. See Figure 27 on 
page 63 for an example of the mxnodesecurity output.

Registering an HP SA Primary Core via SIM MxNode Security

If the protocol exists and the IP address of the HP SA server is correct, change the 
credentials to those set up in Task 2 on page 50:

mxnodesecurity –a –p dsc_sas –c <username>:<password> -n <SA 
primary core IP Address>

If the protocol exists and the IP address is incorrect, remove the entry with the 
following command:

mxnodesecurity –r –p dsc_sas -n <SA primary core IP Address>

If the protocol does not exist or has just been removed, add the SA entry with the 
following command:

mxnodesecurity –a –p dsc_sas –c <username>:<password> -n <SA 
primary core IP Address>

Verify the account that was just added to the CMS using the following command: 
mxnodesecurity –l

It is important that the same account information that was entered in the Task 2 on 
page 50 be used for this step. The username and password values of this account 
grant CSA for Matrix access to the HP SA primary core OS Sequences and 
Application Polices and allow basic server operations through HP SA.
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To make sure HP Systems Insight Manager uses these new credentials immediately, 
restart the HP SIM server. 

1 Make sure there is no activity on the HP SIM server during the restart.

2 Restart the HP SIM from the control panel or by running the following commands. 

To stop HP SIM:

mxstop

To start HP SIM:

mxstart

HP SIM requires some time to restart. To monitor the status of the HP  SIM restart 
run:

mxstatus –w -v

Upon completion, mxstatus returns SIM status: Ready.

Figure 27 shows a sample listing. In this case, the account name that was used for 
CSA for Matrix access is hpiosa_admin and the IP address of the HP SA primary 
core is 15.6.136.4.

Figure 27 mxnodesecurity example 

Verifying HP SA Deployment Server Access 

Once the HP SA primary core has been registered the system begins receiving 
software inventory directly from the HP SA primary core. Go to the HP IO operations 
console and refresh the software inventory to verify that HP IO lists the inventory.
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Figure 28 shows both operating systems (OS) sequences and application policy (App) 
inventory in the Type column with HP SA (shown as SA) in the Source column. The 
Location column (not shown) should show the HP SA primary core IP address that 
was registered in Registering an HP SA Primary Core via SIM MxNode Security on 
page 62.

Figure 28 Verifying HP SA Software Inventory 

Other HP Insight Dynamics CMS Configuration Topics

This section is provided as reference. Typically, the following Insight Dynamics 
configuration procedures are completed as part of preparing the managed resources. 

Support for HP c-Class Blades with Virtual Connect 

CSA for Matrix supports c-Class blades using Virtual Connect for integration with HP 
SA. The c-Class blades may use a Fiber Channel (FC) SAN boot disk or a local boot 
disk presented through an onboard RAID controller and optionally one or more 
FC-SAN data disks. In this initial release, only single-path FC-SAN connectivity has 
been qualified. 

To succeed, the operating system deployment process depends upon having only a 
single path to the target FC-SAN boot disk visible to the c-Class blade. The single 
path constraint can be enforced by constructing an FC-Fabric zone definition that 
contains a single initiator and a single target world-wide-name (WWN). Alternatively, 
the single path constraint can be enforced by mapping the FC-SAN disk to one disk 
array controller port on the target disk array. 
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PXE NIC Boot Order Requirement 

HP BladeSystem Matrix has been qualified to use PXE as the basic boot and OS 
deployment mechanism with HP SA. In order to support the full provisioning lifecycle 
for a c-Class blade, the PXE NIC must be moved into the first position of the Standard 
Boot Order (IPL) 

Move PXE NIC to First Position of Standard Boot Order (IPL) for c-Class Blade

1 Power the blade on and allow it to POST. 

2 Select F9 to force the system into the ROM-Based Setup Utility (RBSU). 

3 As shown in Figure 29, select the Standard Boot Order (IPL): 

Figure 29 Selecting Standard Boot Order (IPL) 

4 Adjust the order of the PXE NIC to the first position as shown in Figure 30 on 
page 66. 

This modification ensures that the c-Class blade is capable of contacting the HP SA 
primary core over the course of its lifecycle. This means that the server always 
attempts to contact the HP SA primary core. If there are no HP SA specific operations 
to perform or if the HP SA primary core cannot be contacted, the server boots from its 
disk.

Enable PXE NIC

If the PXE NIC is not enabled, the NIC does not appear in the IPL list shown above. 
To remedy this situation, perform the following steps: 

1 Select System Options from the from within RBSU. 

2 Select Embedded NICs. 
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3 Select NIC 1 Boot Options to enable the PXE function. 

Figure 30 Enabling the PXE function on a c-Class Blade 

4 Once these changes are made, reboot the server.

5 Repeat steps 2-4 of Move PXE NIC to First Position of Standard Boot Order (IPL) 
for c-Class Blade on page 65 to re-enter RBSU and configure the correct boot 
order. 

Once the PXE NIC configuration has been completed through RBSU, it remains in 
effect indefinitely. The c-Class blade is now “automation ready” and can be used by 
CSA for Matrix to create a new service. 

OS SAN Boot Driver Requirements 

1 QLogic HBA (BIOS version 2.07 or higher) 

a RHEL 5.3 and higher 

b Windows 2003/2008: QLogic driver 9.1.7.29 or higher 

2 Emulex HBA (BIOS version 3.11a5 or higher) 

a RHEL 5.4 or higher 

b Windows 2003/2008: Emulex driver 5.00.17.06-2 or higher 

Supporting VMware Virtual Servers 

HP BladeSystem Matrix has qualified VMware virtual machines for integration with 
HP SA. Like c-Class blades, a VM must be able to PXE boot against the SA primary 
core in order to execute its operating system and application provisioning process. 
Unlike c-Class blades, there is no required manual configuration for the VM. Instead, 
BladeSystem Matrix automatically enables and adjusts the PXE boot order for the 
VM as a part of the operating system and application deployment process. 
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As of this software release, there are no VM specific driver-level-requirements 
necessary to accomplish basic operating system provisioning for all of the currently 
qualified OS types.

Configure ESA

The Extensible Storage and Server Adapter (ESA) is used with HP non-VC-enabled 
ProLiant servers. It provides a facility to import non-VC-enabled servers into the 
HP IO server pools. For a complete description of this configuration refer to 
“Configuring Insight Orchestration to list heterogeneous hardware” in the HP Insight 
Orchestration User Guide.

The reference workflows are driven by three data files. These files are located in 
C:\Program Files\HP\Insight Orchestration\esa_extensions\server

— inventoryList.xml

— serverInfo.xml

— uuidHostMapper.xml 

When adding a new server type for use through an OO workflow, the HP IO 
blade_models.properties file must be updated to include the new model: 

Edit C:\Program Files\HP\Insight 
Orchestration\conf\blade_models.properties 

HP IO uses the contents of this file to determine which server model types to permit 
for HP IO operations.

Discover the HP SIM Managed Resources

HP SIM must identify servers that it will manage on behalf of HP IO. The discovery 
process finds physical servers and VM host servers.

Discovery Steps (can be applied to any resource)

1 Log into HP SIM.

2 From the Options menu select Discovery... 

3 Create a discovery task, filling in a single IP address or range of IP addresses to 
discover. 

a Select Credentials.

b For each server or device on the subnet, enter the credentials and press OK. 

c Press Save to save the task.

d Select the new task and press Run Now.

The HP IO and HP SIM installation folder is the folder that you entered during 
installation.

Discovery of Linux servers might require editing the /etc/ssh/sshd_config setting 
the following variables:

PermitRootLogin yes
PasswordAuthentication yes
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Configure HP IO to Use Blades

1 Discover the Onboard Administrator (OA). Use the Discovery Steps (can be 
applied to any resource) on page 67 to discover the OA. All the blades and related 
devices are automatically discovered when the OA is discovered. 

2 Enter the credentials for the OA. 

a Enter IP addresses for both OA and VC servers as part of a single discovery 
task.

b Select Credentials.

c For each server or device on the subnet, enter the credentials and press OK. 

d Press Save to save the task.

e Select the new task and press Run Now.

3 Confirm the VC Domain is discovered.

a From SIM, select Tools->Integrated Consoles->Enterprise Manager (VCEM).

b Select the VC Domains tab and confirm a domain exists with the serial number 
of the enclosure.

4 Create a VC Domain Group. 

a Select the VC Domain Group.

b Press New.

c Select the VC Domain and press Next.

d Enter the Virtual Connect credentials. Enter a VC Domain Group name. Use 
either the VCEM defaults or the factory settings for the Serial number, MAC 
and WWN drop down box. 

e Press OK. 

5 Connect to the OA of the blade enclosure.

a Shut down each blade to be used in HP IO provisioning. 

6 Remove blade profiles.

a While in VCEM, select the Bay tab. (This can also be done from the Profiles 
tab.)

b For each blade to be used as a target server for HP IO provisioning, unassign 
the profile.

You need to apply the HP Virtual Connect Enterprise Manager (C7000 or similar) 
license before adding it to the domain group. Refer to Applying Licenses on page 72.

Write down the WWN, MAC, and serial range values from Virtual Connect before 
creating the new VC Domain. This information is necessary if you want to release 
CMS control of VC at any time.
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7 Create the storage pool entries. 

8 Refresh the Logical Server Manager. 

a From the HP SIM Tools menu, select Virtualization Manager.

b Select Tools >Logical Servers >Refresh.

c Select the check boxes for Virtual Connect Enterprise Manager (VCEM), Static 
Servers, and Storage Pool Entries. 

d If you have non-VC-enabled servers, press Refresh to refresh the static servers.

Discover VMWare ESX 

To configure an ESX server for inclusion in HP IO, ESX requires a Virtual Center 
Server to be present and managing the ESX server. 

1 Discover the ESX server and Virtual Center as part of the single discover step a 
on page 68.

2 Discover the Virtual Center server. 

3 License ESX. See Applying Licenses on page 72.

4 Set up Virtual Center by adding the VC credentials to Options >VMware vCenter 
Settings.

5 Register the VMHost with VMM. 

a Select Configure > Virtual Machine > Register Virtual Machine Host.

b Select the ESX VM Hosts collection; then select View Contents and the target 
server.

c Press the Apply button; then press Next and Run Now.

d Wait for the task to complete. 

Windows Hyper-V Discovery Steps

1 Discover the Hyper-V.

a Select Credentials.

b For each server or device on the subnet, enter the credentials and press OK. 

c Press Save to save the task.

d Select the new task and press Run Now.

2 License Hyper-V. See Applying Licenses on page 72.

3 Register the Hyper-V server with VMM.

• Registering the Hyper-V server with VMM is similar to registering ESX (see 
Discover VMWare ESX); however, you must use the option Hyper-V VM Hosts 
instead of ESX VM Hosts.

Information on how to create storage pool entries can be found in Insight Dynamics—
Automated Storage Provisioning: Static SAN volume automation via multi-initiator 
NPIV at http://www.hp.com/go/insightsoftware/docs. Local storage is used 
differently. Refer to Local Disks on VC and non-VC-enabled Servers on page 71.

To use the “Dynamic” SAN volume automation feature, see the HP Insight 
Orchestration 6.2 User Guide.
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Non-VC-enabled Server Discovery Steps

1 Make sure you have completed the steps under Configure ESA on page 67.

Go to C:\Program Files\HP\Insight 
Orchestration\esa_extensions\server to modify the inventoryList.xml, 
serverInfo.xml, and uuidHostMapper.xml files containing required 
information on non-VC-enabled servers.

2 Provide the uuid value of the non-VC-enabled server you want to add within the 
file inventoryList.xml.  

3 Edit the serverInfo.xml file to include the XML tags, as described in the Server 
and Storage Workflows for HP Insight Dynamics at http://www.hp.com/go/
insightsoftware/docs. Make sure that you include the following tags: the 
<cpuFamily> tag containing the value x86System, and the <rackName> tag and 
<rackPosition> tag containing appropriate values. After the non-VC-enabled 
server is discovered and added to the HP IO server pool, verify that the server 
information you provided in the serverInfo.xml file matches the information 
that HP IO sees. 

— Go to the HPIO Server Pool tab.

— Select the entry associated with the server to view the detailed information 
about the server.

— Review and update the serverInfo.xml files as necessary.

4 Note the serverModel information you provided in the serverInfo.xml file for 
the non-VC-enabled server (for example, ProLiant DL 380 G5). Using your server 
model information, edit C:\Program Files\HP\Insight 
Orchestration\conf\blade_models.properties

5 Add the associated entries for the server. For example:
x86_64_Models=Proliant DL 380 G5 
SUPPORTED_MODELS=Proliant DL580 G5 

6 Edit the uuidHostMapper.xml file. Enter the same uuid that matches the value 
provided for the server in the serverInfo.xml and inventoryList.xml files. 

7 Add the IP/name for the ILO associated with the non-VC-enabled server. 

8 Stop these services: LSA, HP IO, ESA, RSCentral, and REJRAS.

9 Restart the services in reverse order: REJRAS, RSCentral, ESA, HP IO, and LSA.

This triggers the GETSERVERINVENTORY and GETSERVERINFO flows, which import 
the non-VC-enabled servers into the HP IO server pool as Unassigned.

Incorrect tags in ServerInfo.xml, not providing model numbers for non-VC-enabled 
servers, or incorrect credentials for iLOs associated to non-VC-enabled servers cause 
the OO flows to fail. Non-VC-enabled servers are not listed in HP IO. Credentials for 
non-VC-enabled servers are added by using HP OO Studio.

Any editing of ServerInfo.xml requires a restart of services before HP IO reports 
the changes.

If a non-VC-enabled server SAN boot disk is used, then the serverInfo.xml file should 
list the local disk as null. For example: <localStorageList xsi:nil="true"/>.
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10 To view the status of the flows, run the launch page at https://localhost:16443/
PAS/app. Log in with the HP OO administrator credentials provided during 
HP Insight Dynamics integrated installation. 

11 On the left side of the HP OO Central UI, you can see the flows that have run 
previously and view their status. Each time the flows are run (either manually by 
restarting the HP LSA service or automatically) the number of times run 
increments. 

12 Double-click each flow to see reporting information about the flow. Left-click any 
of the History IDs to see associated steps for that entry. The Basic and Advanced 
tab flows provide useful information for troubleshooting. The reported result of 
each step should be success. 

13 To go back to the flow status page, select the Dashboard tab. 

14 If the GETSERVERINVENTORY and GETSERVERINFO flows were completed 
successfully, the non-VC-enabled servers are added to HP IO. 

15 Verify the non-VC-enabled server addition to HP IO by accessing SIM > Tools > 
Insight Orchestration > Server Pools > Unassigned Server Pool. If the server is not yet 
listed, refresh the server pool list. 

16 After you have confirmed that the server has been added you can create a 
dedicated server pool, template, and service request; you can also provision the 
server with an operating system.

Local Disks on VC and non-VC-enabled Servers

To boot a virtual-connect (VC) or non-VC-enabled server from local disk, the disk 
needs to be visible to HP IO. To make the disk visible to HP IO follow the steps below: 

1 Once the VC servers and non-VC-enabled servers are discovered, go to 
C:\Program Files\HP\VSE\bin\ 

2 Run lsmutil --exportAnnotations to create the computeActuals.xml file. 

3 Modify the computerActuals.xml file for the local disk. 

— A sample 'c' class blade in the computeActuals.xml file:

<CliLocalDisk>

<name></name>
<description></description>
<deviceType>0</deviceType>
<storageType></storageType>
<storageDeviceType></storageDeviceType>
<storageSizeType>GB</storageSizeType>
<raidLevel>NONE</raidLevel>
<volumeNumber>1</volumeNumber>
<storageSize>60</storageSize>
<sharable>false</sharable>
<storageSpeed>0</storageSpeed>
<diskStatus></diskStatus>

</CliLocalDisk> 

If you intend to run these flows manually several times in a row, allow enough time 
between the runs for the HP OO Central UI status to update.
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— A sample non-VC-enabled server local-disk in the computeActuals.xml file:

<CliLocalDisk>

<name></name>
<description></description>
<deviceType>0</deviceType>
<storageType></storageType>
<storageDeviceType></storageDeviceType>
<storageSizeType>GB</storageSizeType>
<raidLevel>NONE</raidLevel>
<volumeNumber>1</volumeNumber>
<storageSize>33</storageSize>
<sharable>false</sharable>
<storageSpeed>0</storageSpeed>
<diskStatus></diskStatus>

4 After the file is modified and saved, run lsmutil --importAnnotations. 

Setting Up VC-enabled and non-VC-enabled Servers for SAN Boot

1 In the boot screen of the server, press F9 to bring up the BIOS setup.

2 Select PCI Devices and disable the Smart array controller.

3 Select Standard Boot Order and set the NIC to IPL: 1

4 Select the Boot Controller Order and set the Smart Array controller to last (this 
should not matter if the controller is disabled).

5 Exit the BIOS screen using F10 to save your changes.

6 Additional HPA setup is required. See 

Applying Licenses 

Import Licenses

1 Go to SIM > Deploy > License Manager > Add Licenses

2 Add licenses as needed.

Apply Licenses

1 Go to SIM.

2 From the left panel select All Systems and select all the target servers. Target 
servers include cClass blade servers, Non-VirtualConnect/HP Proliant servers, 
ESX, and HyperV servers, but not ILOs and Management Processors. 

3 Select Quick Launch > Managed System Setup Wizard 

4 Follow each step, selecting all the license options except HP SIM.

5 Click Next until the target servers are successfully licensed.

The information provided in the computeActuals.xml file must match the disk 
information found locally on the server.

If the disks are being updated, you see a message about the current LSM database 
schema version and success updating local disks.
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If you have not already done so in a previous section:

6 Go back to HPSIM > Options > Discovery.

7 Select the link to Add Virtual Center.

8 Add the IP address and credentials for Virtual Center.

9 Register the HP ESX Host. 

HP IO Configuration

To set up HP IO for provisioning, including configuring the network space and 
creating the server pools: 

1 Check the Software tab.

a Make sure the software from the deployment engine (HP SA) is listed. If 
nothing is listed, press Refresh. 

b If the software is not listed after pressing Refresh, check the server 
credentials. 

2 Check the Networks tab.

Networks are listed if OA and VC were discovered successfully and the VC domain 
group was created. However, the network status is critical until the network address, 
netmask, default gateway, and DNS IP address are added manually. 

a Select the option box for the network to be used for provisioning and press 
Edit. 

b Enter the data about the network, the IP address of the network (ending in 0), 
the netmask, and the gateway. Select deployment network.

c Enter the data for the DNS tab, including the domain name and DNS server. 

d Select the number of DHCP addresses. 

e Enter any reserved static IP addresses. 

3 Check the Storage Pools: 

a Storage pools are listed in HP IO only after the user creates SPE/storage pool 
entries.

b Confirm that local storage devices are present. (See Local Disks on VC and 
non-VC-enabled Servers on page 71.) 

4 Check the Server Pool tab:

a The unassigned pool is automatically created. All servers when initially 
discovered are placed in the unassigned pool.

b To create a new server pool, select Create Pool and give the pool a unique pool 
name. 

c From the unassigned pool, select the blades to be used as target servers for 
provisioning. 

d Press >> to move the target servers to the server pool. 

e Press Save. 

f Highlight the pool and select Modify Users. 

g Select the administrator account and any other account that must have access 
to this server pool.
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h Press Assign to move the account access information to the pool, and then 
press Save. 

For VMs the steps are similar:

1 Set up the networks on the Network tab. 

2 Assign the hypervisor to its own server pool. 

3 Storage pools are not required, since the storage comes from the hypervisor. 
HP IO should now be ready for operating system provisioning to a VM. 

Configuring HP Storage Essentials for Use with CSA for Matrix

This is an optional section. Skip this section if you do not want to use HP Storage 
Essentials with CSA for Matrix.

Follow the HP Storage Essentials Installation Guide to install and configure 
HP Storage Essentials for use with CSA for Matrix.

Once ESX/HyperV are discovered and registered, any network set up earlier might be 
listed as Physical or Virtual.

If you are using a previous version of HP IO such as HP IO 6.1 (Update 1) with CSA 
for Matrix, you cannot use the “Dynamic” SAN volume automation feature, and 
therefore, you need not configure HP Storage Essentials for use with CSA for Matrix
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Installing and Configuring CSA for Matrix Flows 
and Templates

This chapter addresses the core processes related to integrating CSA for Matrix in the cloud environment. It 
covers installing flows and templates, confirming that the flows and templates are installed, customizing the 
flows for your environment, and adding SiteScope flows to templates. These processes complete the 
installation, but not the verification. After installation, you must configure resource pools and create a test 
template to verify the installation. Figure 31 shows the high-level processes covered in this chapter.

Figure 31 Installing CSA Software
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Figure 32 expands the SiteScope flow installer process into the following 
subcategories: preparing, installing, configuring, and validation. Evaluate each 
subcategory to determine the steps necessary for your installation.

Figure 32 High-level CSA for Matrix SiteScope Flow Installer Processes 
Expanded 
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Optional. Figure 33 expands the Storage Essentials flow installer process into 
different subcategories.

Figure 33 High-level CSA for Matrix Storage Essentials Flow Installer 
Processes Expanded
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Preparing the Environment for CSA for Matrix Flows

The installation process described below is oriented toward new installations. If the 
CSA for Matrix SiteScope flows have previously been installed, specific steps must be 
taken prior to initiating the installation process. 

The following steps describe the process of checking OO Studio for previously installed 
flows and system properties and clearing them.

Check for Previous Installation and Prepare for Reinstallation of CSA 
Flows 

You cannot upgrade the CSA for Matrix 2010, September, environment to CSA for 
Matrix 2010, December. To migrate to the CSA for Matrix, 2010, December, 
environment, you must perform the following tasks:

1 Upgrade the HP products to the supported versions (versions that are supported 
by CSA for Matrix, 2010, December).

— Upgrade HP Server Automation to 9.02 or 9.03.

— Upgrade HP SiteScope to 11.00 or 11.01.

— Optional. Upgrade HP Insight Dynamics to 6.2 Update 1 if you want to use 
the “Dynamic” SAN volume automation feature.

2 Remove old flows.

To remove old flows, follow these steps:

1 Open OO Studio.

2 Navigate to /Library/Hewlett-Packard/Insight Orchestration/Service Actions.

3 Locate the following flows:

It is unnecessary to Check for Previous Installation and Prepare for Reinstallation of 
CSA Flows if this is a “greenfield” installation. Proceed to Installing CSA for Matrix 
Workflows on page 81.

If you do not remove the previous CSA flows and CSA SiteScope template data from 
the SiteScope server and CMS, the installation procedure will yield unpredictable 
results.
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Deploy Monitors
Disable Monitors
Enable Monitors
Delete Monitors

4 Right-click and select Delete; then answer YES to all prompts.
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5 Navigate to Configuration/System Properties.

6 Delete the following CSA system properties:

SiSFQDN
SiSUserName
SiSPassword 
SiSIPPort 
SiSDefaultMonitorFrequency
SiSProtocol 
SiSCSATemplateFolder

7 Check in changes to the repository:

If SiteScope system properties exist, the installation ignores the 
csaInstall.properties file.
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a Right click Library > Repository > Check in Tree.

b Answer Yes or OK to all prompts.

8 Stop services: 

net stop "RSScheduler"
net stop "RSCentral"
net stop "RSJRAS"
net stop "HP Extensible Storage & Server Adapter"
net stop "HP Logical Server Automation"
net stop "HP Insight Orchestration"

9 Delete the OO metadata directory, including all subfiles:

C:/Program Files/HP/Operations Orchestration/central/rcrepo/
data/.metadata 

10 Restart services: 
net start "RSScheduler"
net start "RSCentral"
net start "RSJRAS"
net start "HP Extensible Storage & Server Adapter"
net start "HP Logical Server Automation"
net start "HP Insight Orchestration"

11 OO is now ready for the CSA flows to be re-installed.

More Information in Log Files and the Readme File

The following log files can provide useful information regarding possible causes of 
errors.

C:\Program Files\HP\Operations 
Orchestration\Central\logs\Central_wrapper.log

C:\Program Files\HP\Operations 
Orchestration\Central\logs\audit.log

C:\Program Files\HP\Operations 
Orchestration\RAS\Java\Default\webapp\logs\wrapper.log

The README file included with the CSA SiteScope Flows installer 
(CSA_for_Matrix_2010.12_OO–SiS–Install.zip) contains additional 
information.

Installing CSA for Matrix Workflows

The Cloud Service Automation for Matrix Product Software and Documentation CD 
provides you with the following flows:

• HP SiteScope flows

The CSA_for_Matrix_2010.12_OO–SiS–Install.zip file, available on the 
Cloud Service Automation for Matrix Product Software and Documentation CD, 
includes necessary files to install the HP SiteScope flows.

The OO installation path is the path that was entered during installation.
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The HP SiteScope Flow Installer installs workflows and SiteScope templates. 
When run on the HP Insight Dynamics CMS, the script installs SiteScope monitor 
OO flows and system properties. When run on the HP SiteScope server, the script 
installs the SiteScope templates. 

Following successful installation, SiteScope workflows can be added to HP IO 
service templates. Refer to Adding HP SiteScope Flows to the Templates on 
page 93. 

CSA for Matrix provides four pre-configured HP OO workflows, which are 
typically paired in an HP IO service template to perform monitoring tasks on a 
managed server. These workflows are added to HP IO templates to simplify the 
process of building templates for these commonly required services.

— Deploy/Delete monitors

– Deploy HP SiteScope monitors to a managed server

– Delete HP SiteScope monitors from a managed service (to delete every 
monitor of the service)

— Disable/Enable monitors

– Disable HP SiteScope monitors from a managed server (when the server is 
deactivated or powered off)

– Enable HP SiteScope monitors from a managed server (when the server is 
activated or powered on)

After you import the CSA for Matrix workflows into OO, you can use SiteScope 
flows in any HP IO service template.

Figure 34 Installing CSA for Matrix Flows and Templates 
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• HP Storage Essentials flows

The Cloud Service Automation for Matrix Product Software and Documentation 
CD presents the CSA_for_Matrix_2010.12_OO–SE–Install.jar file, which 
includes the necessary files to install the HP Storage Essentials flows.

Prerequisites

• Verify HP SA is installed.

• Verify HP IO and HP OO are both installed on the CMS.

• Verify HP SiteScope version 11.00 or 11.01 is installed.

• Verify the Java plug-in is installed for any client browser that runs the 
HP SiteScope the dashboard. 

• Complete HP SiteScope licensing configuration, if necessary.

• Unless this is a clean or “greenfield” installation, the CMS with HP IO and OO 
must be prepared for reinstallation of CSA flows. See Preparing the Environment 
for CSA for Matrix Flows on page 78. 

• Optional. Verify that HP Storage Essentials 6.3 is installed and configured in the 
environment.

If you want to use HP Storage Essentials for dynamic storage provisioning, you 
must update the ESA to the version 1.2.1.1 on the HP Insight Dynamics CMS 6.2 
Update 1. For more information, see Update Extensible Storage and Server 
Adapter (ESA) Workflows to the Version 1.2.1.1 on the HP Insight Dynamics CMS 
6.2 Update 1 on page 58.

Importing and Installing CSA for Matrix Workflows

To import and install the CSA for Matrix workflows, perform the following tasks:

1 Task 1: Import Workflows for HP SiteScope on page 83.

2 Optional. Task 2: Import Workflows for HP Storage Essentials on page 84.

3 Only if SiteScope is installed on a server other than the CMS. Task 3: Import the 
CSA SiteScope Templates into HP SiteScope on a Separate Server on page 85.

Before running the installer programs for CSA for Matrix workflows on the HP OO 
server, you must first stop all HP OO and HP SIM clients.

Import Workflows for HP SiteScope

1 Log on to the CMS as Administrator.

2 Make sure you have placed the CSA_for_Matrix_2010.12_OO–SiS–
Install.zip file on the CMS server from the Cloud Service Automation for 
Matrix Product Software and Documentation media. The file is available in the 
CSA_for_Matrix_2010.12_OO–SiS–Install directory on the media.

3 Extract the contents of the CSA_for_Matrix_2010.12_OO–SiS–Install.zip 
file to a temporary folder on the CMS. 

4 In a Command window, change to the temporary folder.
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5 Edit the csaInstall.properties file, which contains all configurable 
installation parameters.

Property Name Description 
ooDir = OO install directory
ioDir = IO install directory
sisDir = SiteScope install directory
ooLogin = OO Studio username
ooPassword = OO Studio password
SiSFQDN = SiteScope Server Hostname or IP address
SiSIPPort = SiteScope Server Port Number*
SiSUserName = SiteScope Server Login Name
SiSPassword = SiteScope Server Password

6 Unless this is a clean or “greenfield” installation, the CMS with HP IO and OO 
must be prepared for reinstallation of CSA flows. See Preparing the Environment 
for CSA for Matrix Flows on page 78.

7 Run the following command:

install.bat

If all goes well, system reports SUCCESSFUL INSTALL; otherwise it reports 
ERRORS ENCOUNTERED

Import Workflows for HP Storage Essentials

This is an optional section. Skip this section if you do not want to use HP Storage 
Essentials with CSA for Matrix.

1 Log on to the CMS as Administrator.

Install the HP Storage Essentials flow if you want to use CSA for Matrix to 
dynamically provision SAN arrays.

2 Make sure you have placed the CSA_for_Matrix_2010.12_OO–SE–
Install.jar file on the HP CMS server from the Cloud Service Automation for 
Matrix Product Software and Documentation media. The file is available in the 
CSA_for_Matrix_2010.12_OO–SE–Install directory on the media.

3 Copy the CSA_for_Matrix_2010.12_OO–SE–Install.jar file into the 
following directory:

%OO_home%\jre1.6\bin

4 At the command prompt, go to the directory %OO_home%\jre1.6\bin, and then 
run the following command:

java -jar CSA_for_Matrix_2010.12_OO–SE–Install.jar 
-centralPassword <OO_Central_password> -centralURL https://
localhost:16443

In this instance, <OO_Central_password> is the password for your HP OO 
Central.

5 Restart the RSJRAS service from the Services window.

If the CMS server is not cleared of previous CSA flows and CSA SiteScope template 
data, the following step yields unpredictable results.
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Import the CSA SiteScope Templates into HP SiteScope on a Separate Server

Skip this section if HP SiteScope is installed on the CMS.

If HP SiteScope is installed on a remote system (other than the CMS), you must 
import the templates on the HP SiteScope server. 

To import the HP SiteScope templates, follow these steps:

1 Log on to the HP SiteScope server as Administrator.

2 Make sure you have placed the CSA_for_Matrix_2010.12_OO–SiS–
Install.zip file on the 
HP SiteScope server from the Cloud Service Automation for Matrix Product 
Software and Documentation media. The file is available in the 
CSA_for_Matrix_2010.12_OO–SiS–Install directory on the media.

3 Extract the contents of the CSA_for_Matrix_2010.12_OO–SiS–Install.zip 
file to a temporary folder on the HP SiteScope server. 

4 Follow step 4 through step 7 provided in the Import Workflows for HP SiteScope 
on page 83 section.

If the install is successful, you must still verify that the flows and templates were 
properly installed. Refer to Verifying Installation of Flows and Templates on page 86.

If you encountered errors, recheck prerequisites and procedures. Confirm installation 
parameters. If the cause of the error is not apparent, follow the process for Common 
Issues Installing CSA Flows on page 94.
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Verifying Installation of Flows and Templates

Once the installation tasks report SUCCESSFUL INSTALL, you must confirm that 
the flows and templates have been imported properly. Figure 35 shows the verification 
process.

Figure 35 Verifying Installation of Flows and Templates

After installation is complete, you can test whether or not the flows and templates 
have been properly installed by checking the flows. 

Confirm Workflows Appear in OO Studio

Workflows for HP SiteScope

1 Log on to OO Studio.

2 Navigate to Library > Hewlett-Packard > Insight Orchestration > Service Actions.

3 Confirm that the following monitor flows appear:

— Delete Monitor

— Deploy Monitor

— Enable Monitor

— Disable Monitor

If these flows do not appear, you must manually import them into OO Studio. 
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Workflows for HP Storage Essentials

This is an optional section. Skip this section if you do not want to use HP Storage 
Essentials with CSA for Matrix.

1 Log on to OO Studio.

2 Navigate to Library > Hewlett-Packard > CSA > SESANStorage > Flows, and make sure 
the following flows appear:

— SE Discover Arrays

— SE Enumerate Pools

— SE Enumerate Volumes

— SE Get Device Information

— SE Get Volume Info

— SE Present Volume

— SE Set Host Mode

— SE Un-present Volume

If these flows do not appear, you must manually import them into OO Studio. 

Confirm Monitor Templates Appear in HP SiteScope

1 Go to the SiteScope dashboard and review contents of the Templates folder.

Figure 36 Monitor Templates in Templates Folder

2 Verify that the CSA templates folder is present and has two entries: 

— WINDOWS
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— LINUX

3 Configure a user credentials profile for the CSA for Matrix monitor templates.

a In Preferences context, click Credential Preferences.

On the Credential Preferences page, the following user profiles appear:

— WINDOWS-CSA-TARGETS

— LINUX-CSA-TARGETS

These users were added by CSA for Matrix.

b On the Credential Preferences page, select a user. 

Select WINDOWS-CSA-TARGETS for Windows managed systems; select 
LINUX-CSA-TARGETS for Linux managed systems.

c Click Edit Credential Profile ( ).

d In the Edit Credential Profile dialog box, enter the following information:

— Domain: Leave blank unless necessary.

— Login: Specify the name of the administrative user for Windows managed 
systems. Specify root for Linux managed systems.

— Password: Specify the password for the above user.

4 Click Save.

Either a SiteScope specific account needs to be created on each target Windows OS 
and each target Linux OS, or all response files to install operating systems must 
include the root password that matches the credentials entered into SiteScope. CSA 
for Matrix does not support different passwords for each Windows server or for each 
Linux server within SiteScope.
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Configuring and Validating Flows and Templates for the 
Environment

The final step to install the CSA flows and templates is customizing and validating 
the flows for the environment.

Figure 37 Customize and Validate CSA Flows and Templates

Configure the Flow Inputs for Your Environment

Configure the HP SiteScope Workflows

1 Start OO Studio.

2 In the Authoring pane, click Check Out (  ).

3 In the Repository pane, expand Configuration > System Properties.

4 Change the following input properties to values corresponding to your 
environment:

— SiSFQDN: <fully qualified domain name of your SiteScope 
server> 

— SiSUserName: <SiteScope server's administrator username> 

— SiSPassword: <SiteScope server's administrator password>
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— SiSIPPort: <IP port of your SiteScope service from SiteScope 
install time>

— SiSProtocol: <HTTP access protocol to your SiteScope server>

— SiSCSATemplateFolder: <CSA templates folder on your SiteScope 
server>
SiSDefaultMonitorFrequency: <monitor frequency in seconds for 
your CSA monitors>

5 Click File > Save.

6 In the Authoring pane, click Check In (  ).

Configure HP Storage Essentials Workflows

This is an optional section. Skip this section if you do not want to use HP Storage 
Essentials with CSA for Matrix.

1 Start OO Studio.

2 In the Authoring pane, click Check Out (  ).

3 In the Repository pane, under System Properties, double-click SECMSIP.

4 In the Authoring pane, type the IP address of the HP Storage Essentials 
management server in the Property Value box. If the HP Storage Essentials 
management server is configured to use a non-default port, type the IP address in 
the following format:

<IP_Address>:<Port>

In this instance, <IP_Address> is the IP address of the HP Storage Essentials 
management server and <Port> is the non-default port.

5 In the Repository pane, under System Accounts, double-click SECredentials.

6 In the Authoring pane, type the user name and password of the HP Storage 
Essentials user.

7 Click File > Save.

8 In the Authoring pane, click Check In (  ).
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Figure 38 shows editing of the system properties in OO Studio.

Figure 38 Editing the System Properties in OO Studio

Additional Configuration for HP Storage Essentials Workflows

This is an optional section. Skip this section if you do not want to use HP Storage 
Essentials with CSA for Matrix.

If you have installed the HP Storage Essentials flows on the CMS, you must edit the 
esa.properties file to add references to the HP Storage Essentials flows.

To edit the esa.properties file, follow these steps:

1 Log on to the CMS as Administrator.

2 Go to the following directory:

C:\Program Files\HP\Virtual Server Environment\conf

3 Open the esa.properties file with a text editor program.

4 Go to the section #STORAGE WorkFlows.
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5 Edit the following properties:

6 Save the file.

7 For XP and HDS only. If the storage system has four or more ports on the fabric, 
you must increase the operation time-out value.

a On the CMS, open the wrapper.conf file with a text editor. The file is 
available in the directory C:\Program Files\HP\Operations 
Orchestration\Central\conf.

b Add the following line in the file:

wrapper.java.additional.3=-Dras.client.timeout=24000

c Save the file.

d Restart the RSCentral service from the Services window.

Property Set the value to...

esa.oo.get.device.info.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Get Device 
Information

esa.oo.enumerate.pools.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Enumerate Pools

esa.oo.enumerate.volumes.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Enumerate Volumes

esa.oo.get.volume.info.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Get Volume Info

esa.oo.get.volume.info.flow.timeout 1200000

esa.oo.present.volume.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Present Volume

esa.oo.present.volume.flow.timeout 2400000

esa.oo.un-present.volume.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Un-present Volume

esa.oo.un-present.volume.flow.timeout 2400000

esa.oo.set.host.mode.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Set Host Mode

esa.oo.set.host.mode.flow.timeout 2400000

esa.oo.discover.arrays.flow.path Hewlett-Packard/CSA/
SESANStorage/Flows/
SE Discover Arrays
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8 Restart the HP Extensible Storage & Server Adapter service from the 
Services window.

Adding HP SiteScope Flows to the Templates

1 In the IO Designer when editing the template, select Workflows... as shown in 
Figure 39.

Figure 39 Adding SiteScope Flows to Templates

2 Expand all (press the ++ button). 
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3 Select the Deploy Monitor Template and select the Create Service End and Add 
Servers check boxes as shown in Figure 40.

Figure 40 Workflow Add Screen

4 Press Add. 

5 Press OK. 

6 To add the deletion flow, expand all. (Press the ++ button.) 

7 Select the Delete Monitor Group and check the Delete Service Beginning check box. 

8 Press Add. 

9 Press OK.

10 Repeat steps 4 and 5 for the Add Services check box.

Common Issues Installing CSA Flows

Manually Import the SiteScope Monitor Templates 

1 In the HP SiteScope Dashboard, create a template container for the CSA for 
Matrix server monitor templates:

Optional: Use these procedures as backup to the installation procedure in Installing 
CSA for Matrix Workflows on page 81.
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a In the Templates context, click New ( ), and then click New Template 
Container.

b In the New Template Container dialog box, enter the following information:

— Name: Name must match the value of SiSCSATemplateFolder entered in 
the system properties in OO Studio as described on page 90.

— Description: Descriptive text

2 Import the SiteScope templates to the new template container:

a In the Templates context, right-click the template container you created in 
step 1, and then click Import.

b In the HP SiteScope Import Template dialog box, enter the following 
information:

— File Name: csa-servers.tmpl

— Path: C:\SiteScope\export

3 Follow the steps in Confirm Monitor Templates Appear in HP SiteScope on 
page 87.

Installing and Configuring HP Storage Essentials Flows at a Later 
Time

You can choose to install HP Storage Essentials workflows at a later time—after 
installing and configuring the HP SiteScope workflows.

To install and configure HP Storage Essentials workflows after deploying the CSA for 
Matrix solution with SiteScope workflows, follow these steps:

1 Make sure the version of HP Insight Dynamics is 6.2 Update 1.

2 Verify that HP Storage Essentials 6.3 is installed and configured in the 
environment.

3 Follow the steps in Import Workflows for HP Storage Essentials on page 84.

4 Verify that the import was successful by following the steps in Workflows for HP 
Storage Essentials on page 87.

5 Follow the steps in Configure HP Storage Essentials Workflows on page 90.

6 Follow the steps in Additional Configuration for HP Storage Essentials Workflows 
on page 91.

The SiteScope installation path is the path that was entered during installation.
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Migrating to a Standalone OO Installation

HP IO embeds the 7.51 version of HP OO and contains a limited edition of the OO content to 
facilitate server provisioning. If you like, you can migrate to a complete, standalone version of 
OO (Windows only) only after deploying the CSA for Matrix solution. You can migrate to the 
following complete versions of OO only after installing and configuring all flows and 
templates for CSA for Matrix by utilizing the embedded version of OO:

• 7.51

• 9.00

To migrate to a standalone OO installation, follow these steps:

1 Complete the installation of OO on a standalone server (Windows only).

2 On the standalone OO server, create the following directory:

C:\tmp

3 Migrate the embedded OO configurations to the standalone OO server. For necessary 
instructions, contact your HP Insight Dynamics representative.

4 Optional. Migrate HP Storage Essentials Workflows.

5 After completing the migration steps, log on to the standalone OO server, and then follow 
the steps in Configure the Flow Inputs for Your Environment on page 89.

Migrate HP Storage Essentials Workflows

If you want to use the optional integration between HP IO and HP Storage Essentials, 
migrate the HP Storage Essentials JAR files and workflow repository to the standalone OO 
server.

1 Migrate the JAR files.

Transfer the JAR files for CSA for Matrix to the standalone OO server.

a Log on to the CMS.

b Go to the directory C:\Program Files\HP\Operations 
Orchestration\RAS\Java\Default\repository.

c Transfer the files csaseesa.jar and csastorageautomation.jar to the standalone 
OO server by using a file transfer mechanism.

d Go to the directory C:\Program Files\HP\Operations 
Orchestration\RAS\Java\Default\repository\lib.

e Transfer the directories csaseesa and csastorageautomation to the standalone OO 
server by using a file transfer mechanism. Transfer the complete directories and not 
just the contents of the directories.

You cannot install CSA for Matrix workflows on a standalone OO server. You must 
complete the installation of all the CSA for Matrix workflows on the CMS, and then 
you must migrate the workflows to the standalone OO server.
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On the standalone OO server, follow these steps:

a Place the csaseesa.jar and csastorageautomation.jar files in the 
following directory:

%ICONCLUDE_HOME%\RAS\Java\Default\repository

b Place the csaseesa and csastorageautomation directories in the following 
directory:

%ICONCLUDE_HOME%\RAS\Java\Default\repository\lib

c Restart the RSJRAS service from the Services window.

2 Migrate the workflows.

a On the CMS, open OO Studio.

b In the Repository pane, expand Library > Hewlett-Packard, and then right-click 
CSA.

c Select Repository > Export as New Repository.

d In the Select Repository Directory dialog box, go to a directory on the 
standalone OO server. For example:

\\<OO-server>\C$\tmp\CSA

In this instance, <OO-server> is the FQDN of the standalone OO server.

e Click Save. The Export Options dialog box opens.

f Make sure that the following items are not selected in the export options:

– Domain Terms

– Selection Lists

– System Properties

– System Accounts

g Click OK.

3 Import the HP Storage Essentials flow repository on the standalone OO 
server.

a Log on to the standalone OO server.

b Open OO studio.

c Click Repository > Import Repository. The Select Repository Directory dialog box 
opens.

d Select the directory where you transferred the HP Storage Essentials flow 
repository from the CMS.

e Click Open.

f In the Importing From dialog box, click Apply.

g In the Import dialog box, click OK.

Alternatively, you can choose a local folder in the Select Repository Directory dialog 
box. OO saves the repository in a local folder of your choice. You must then transfer 
the complete folder on the standalone OO server.
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Using HP Cloud Service Automation for Matrix

The architect creates service templates that describe commonly requested services. Each template is based on 
one type of available network resource as defined by the network administrator. A business user then selects 
a template in the self-service portal and customizes the template to request service provisioning.

Designing Service Templates

A service template defines one type of service that a business user can request. Each template 
contains the information necessary to provision that service. Create a unique service template 
for each supported server type.

For an overview of the operations that you can include in a service template, see “Insight 
Orchestration provisioning and allocation” in the HP IO User Guide.

The network architect uses the HP IO Designer for the following tasks:

• Create, test, and publish a service template.

• Maintain a service template.

• Delete a service template.

For an overview of the HP IO Designer, see “Using Insight Orchestration Designer” in the 
HP IO User Guide. For more detailed information, see the Designer help.

Managing Resources and Services

The network administrator uses the HP IO console for the following tasks:

• View the status, progress, and details of completed and in-process service provisioning 
requests.

• Approve or reject service provisioning requests.

• View available resources.

• Manage resource pools.

• Manage Self-Service portal users.

For an overview of the console, see “Using Insight Orchestration console” in the HP IO User 
Guide. For more detailed information, see the Console help.

Requesting Services

The business user uses the HP IO Self-Service portal for the following tasks:
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• Request that a service be provisioned.

• Monitor the progress of the service provisioning.

• Delete a service that is no longer needed but has not yet expired.

• Request a change in the lease duration of a service (add more time, request less 
time, or request suspension).

For an overview of the Self-Service portal, see “Using Insight Orchestration 
Self-Service portal” in the HP IO User Guide. For more detailed information, see the 
Portal help.
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Acronyms
A - B

APX

application platform extension

C

CIFS

common internet file system

CMDB

configuration management database

CMS

central management server

CMSD

central management server domain

CSA

HP Cloud Service Automation

CSA for Matrix

HP Cloud Service Automation for Matrix

D

DA

Deployment Automation 

DAS

direct access storage

DHCP

dynamic host configuration protocol

E-G

ESA

Extensible Storage and Server Adapter

EVA

Enterprise Virtual Array

FC

fibre channel

H

HP ID

HP Insight Dynamics

HP IO

HP Insight Orchestration

HP SIM

HP Systems Insight Manager

I - J

ICE

Insight Control Environment

ICMP

internet control message protocol.

ID

HP Insight Dynamics

ID-VSE

HP Insight Dynamics Virtual Server Environment

iLO

integrated lights out

IO

HP Insight Orchestration

IPL

standard boot order

ITSM

IT service management
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L

LDAP

lightweight directory access protocol

LSA

logical server adapter

LSM

Logical Server Manager

LUN

logical unit number 

M

N

NIC

network interface controller

NOC

network operations center

O

OA

Onboard Administrator

OO

HP Operations Orchestration

OS

operating system

P - Q

PXE

pre-boot execution environment

R

RAID

redundant array of independent disks

RBSU

Rom-Based Setup Utility

RDP

Rapid Deployment Pack

RHEL

Red Hat Enterprise Linux

RHELSA

Red Hat Enterprise Linux Server Automation/
Architecture

S

SA

HP Server Automation (SA)

SAP

servers, applications, and products

SAN

storage area network

SE

Storage Essentials

SiteScope

HP SiteScope software used to monitor servers. 

SLA

Service Level Agreement, Software License 
Agreement

SLES

SUSE Linux Enterprise Server

SLM

service lifecycle management

SOA

service-oriented architecture

SOI

Support Operations Integration

SPE

Storage Pool Entries

SPM

Storage Provisioning Manager

SuSE

Linux operating system
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U

UCMDB

HP Universal Configuration Management Database

V

VA

virtual application, virtual array

VC

Virtual Center, Virtual Connect

VCEM

Virtual Connect Enterprise Manager

VCRM 

Version Control Repository Manager

VLAN

virtual local area network

VMM

virtual machine manager

VSAN

virtual storage area network

VSE

HP Insight Dynamics - VSE (formerly the 
HP Virtual Server Environment)

W

WSDL

web service definition language
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